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SUMMARY: 
Here, we provide a detailed description of the procedure to induce colonoscopic-guided pinch biopsies in mice and track wound closure in real time. Additionally, methods for the preparation of tissues for histological, immunohistochemical and molecular analyses of the wound bed are provided. 

ABSTRACT:
Understanding the tissue and cellular changes that occur in the acute injury response as well as during the wound healing process is of paramount importance when studying diseases of the gastrointestinal (GI) tract. The murine colonic pinch biopsy model is a useful tool to define these processes. Additionally, the interplay between gut luminal content (e.g., microbes) and the colon can be studied. However, wound induction and the ability to track wound closure over time in a reliable manner can be challenging. Moreover, tissue preparation and orientation must be carried out in a standardized way to optimally interrogate histologic and molecular changes. Here, we present a detailed method describing biopsy-induced injury and the monitoring of wound closure through repeat colonoscopies. An approach is described that ensures consistent and reproducible measurements of wound size, the ability to collect the wound bed for molecular analyses as well as visualize the wound bed upon sectioning of tissues. The ability to successfully carry out these techniques allows for studies of the acute injury response, wound healing and luminal-host interactions within the colon. 

INTRODUCTION:
The gastrointestinal (GI) tract is a complex organ system, given its multiple functions, host cell types (e.g. epithelial, immune, stromal, etc.) as well as trillions of microbes. In light of this complexity, diseases of the GI tract often involve the interplay of all of these factors. For example, inflammatory bowel diseases (IBD) are associated with cycles of inflammation and remission in the GI tract, involving the activation of inflammatory cells, dysbiosis, and epithelial repair1-7. Having appropriate model systems to study IBD and other inflammatory conditions of the GI tract is critical for elucidating the pathogenesis of disease. Several models exist to study IBD pathogenesis including genetically engineered mice and the use of chemicals such as dextran sodium sulfate (DSS) in rodents8-10. Limitations of these models include an inability to precisely control the induction of inflammation as well as difficulties in evaluating wound healing. Alternative methods to mimic aspects of IBD pathogenesis could prove useful for developing therapies.

Colonoscopic-guided pinch biopsies in mice offer a useful model system to study the pathogenesis of the inflammatory response, wound healing as well as host-microbe interactions in the colon. This approach was first used as an experimental tool in 2009, which demonstrated its utility for studying the acute inflammatory response and wound healing in the gut11. Subsequent studies utilized this technique to evaluate the roles of different signaling pathways as well as the gut microbiota, in colonic wound healing11-18. More recently, our group used this model to investigate the importance of sphingosine-1-phosphate signaling and bacteria in the acute response to colonic injury19. Although useful, carrying out colonoscopic-guided pinch biopsies in mice and evaluating subsequent tissue changes can be technically challenging. For instance, perforation of the bowel can occur upon induction of injury and ensuring consistent measurements of the wound bed through serial colonoscopies can be difficult. Additionally, orienting the colonic tissue properly to visualize the wound bed for histological or immunohistochemical analyses can be challenging. Although some information does exist regarding these methods18,20, a precise step-wise description of these techniques along will visual aids promises to enhance the reliability and broader utility of this model. Here, we present a detailed method to carry out colonoscopic-guided pinch biopsies in mice, track wound closure over time and prepare the tissue to enable histologic and molecular analyses of the wound bed. Creating a standard method to carry out these techniques can expand the use of this model to study previously uninvestigated mediators that are potentially important for GI inflammation and wound repair. 

PROTOCOL:

All procedures described here were approved by the Institutional Animal Care and Use Committee of Weill Cornell Medicine.

1. Colonoscopy and wound induction
[bookmark: _Hlk30596833]
1.1. Pre-assemble the components of the endoscope by first inserting the 1.9 mm rigid bore endoscope into the sheath (Figure 1A-B). Attach the air pump (to provide colonic insufflation) using the tubing provided, to the gas valve on the left side of the sheath next to the working channel (Figure 1C). 

NOTE: Although the lens described here is 0°, a 30° lens can also be used for this purpose. 

1.2. Ensure that the working channel is in the open position and insert 3 Fr biopsy forceps through the working channel and advance it until the end of the sheath (while ensuring that it does not protrude out of the sheath) (Figure 1C). Attach the assembled endoscope to the light source and video imaging device per manufacturer’s instructions. 

1.3. Anesthetize the mouse with 2% isoflurane with oxygen in an induction chamber. Then move the mouse to an endoscopic staging platform on its ventral side and maintain under anesthesia using a nose cone. 

NOTE: Any strain or either gender of mice can be used with this technique; however, it is preferable that mice are at least 8 weeks of age so they are large enough for the procedure.

1.3.1. Add vet ointment to the eyes to prevent dryness while under anesthesia. 

1.3.2. Ensure that the mouse is fully anesthetized by gently pinching the rear foot to test for a reflex. 

1.4. Fill a 3 mL syringe with an attached rat gavage needle with room temperature phosphate-buffered saline (PBS). Insert needle approximately 1 cm into the mouse’s anus and gently infuse PBS to clear fecal material. Several fecal pellets should exit the mouse along with the PBS that was infused. 

NOTE: Instillation of an excessive volume of PBS can result in foam formation in the lumen which could obscure viewing of the lumen. 

1.5. Insert the assembled endoscope 0.5 cm into the anus of the mouse. Advance the biopsy forceps into the lumen of the rectum until the full ‘jaws’ (including hinge) of the forceps are beyond the end of the sheath (as observed on the video monitor) (Supplemental Video 1). Turn the forceps 90° so that the jaws open in an east-west orientation (Supplemental Video 1). 

1.6. To biopsy, open the forceps and advance approximately 1 cm, close the forceps and in one smooth motion quickly pull back on the forceps while leaving them closed (Supplemental Video 1). 

1.6.1. Avoid fully insufflating the colon when performing the biopsy. Therefore, leave the right side of the gas valve open during this step; although it should be noted that upon opening the forceps there is a risk of damaging the mucosa when the colon is in this position.

2. Visualizing and measuring the wound bed

2.1. Initiate video recording immediately after biopsy by pressing the foot pedal attached to the colonoscope recording device. Fully insufflate the colon by firmly pressing an index finger against the right side of the gas valve to completely cover the opening in order to force the air into the endoscope and thus into the colon. 

NOTE: Although this protocol describes the use of an air pump in which the air flow is manually controlled, a peristaltic pump with a controlled air supply can also be used.

2.2. Advance the forceps back out of the sheath, and into the rectal lumen while in the closed position (Supplemental Video 1). Place the forceps against the rectal wall immediately above the wound until the base of the jaws is aligned with the top edge of the viewing field (Figure 2 & Supplemental Video 1). Continue fully insufflating the colon until a clear view of the wound can be observed. 

NOTE: Care should be taken to extend the forceps far enough to reveal only the jaws of the forceps up to the base in order to ensure a consistent distance between the lens of the endoscope and the lesion (Figure 2, white arrow). 

2.3. If carrying out biopsies on multiple mice on the same day, remove the biopsied tissue of the previous mouse from the forceps (using the cleaning brush provided) and wipe down the lens sheath with 70% ethanol to clean it before inducing a wound in the next mouse. 

NOTE: Although this protocol describes carrying out a single biopsy per mouse, multiple biopsies can be performed on a single mouse provided the tissue taken from the prior biopsy is removed from the forceps in order to ensure a full biopsy can be taken on subsequent biopsies. 

2.4. Place the mouse into a cage void of other mice and on top of a towel to keep the airway clear until it recovers from the anesthesia after completing the procedure. Monitor mouse to ensure that it recovers from the anesthesia as indicated by regaining activity. 

NOTE: Two people are required to induce the wound and visualize the wound bed on day 0 (one operating the endoscope and the other operating the biopsy forceps) but only one individual is needed for visualizing wounds on subsequent days (as described below). 

2.5. Follow the same procedure for preparation of the mouse and colonoscopy for subsequent wound measurements (typically, days 2, 4 and 6 following biopsy), as described above in sections 1.1-1.4, except for the induction of the wound. 

2.6. Locate the wound bed on the video monitor at these time points after inserting the endoscope, and advance the biopsy forceps (in the closed position) to immediately above the wound bed, insufflate the colon and initiate video recording, as described in sections 2.1 and 2.2 (Figure 2). 

NOTE: It can be difficult to locate the wound bed more than 6 days following biopsy.

2.7. Advance the forceps into the lumen on these subsequent days to the same distance as on day 0 to ensure a consistent distance between the lens of the endoscope and the lesion across days. Ensuring a consistent distance between the lens and lesion will enhance the accuracy of measurements over time. 

NOTE: One individual can carry out measurements on these days (endoscope is operated with the right hand and the biopsy forceps are advanced with the left hand). 

2.8. [bookmark: _GoBack]Once all measurements are completed, open the video recordings of the serial colonoscopies in video editing software that enables the creation of still shots from video. 

2.9. Advance the video to a frame showing a point in time when the wound bed can be easily visualized, the closed forceps are above the wound bed and against the rectal wall and the wall is taut. Take a snapshot of this frame and code the file name to ensure that measurements of the wound beds are carried out in a blinded manner.

2.10. Open the images with coded file names in NIH ImageJ to quantify the size of the wound bed. Under the Analyze tab, select Set Measurements and check the Area box. 

2.10.1. Select the Freehand selections tool from the main menu bar and draw a perimeter around the wound (see Figure 2). Under the Analyze tab select Measure and the value of that measurement will automatically populate in the Results window. 

2.11. Export the results into a spreadsheet after completing measurements for all images, by selecting Save As under the File tab within the Results window and changing the extension to become a spreadsheet file. 

2.12. Calculate the size of the wound on days subsequent to the induction of the wound (i.e. days 2, 4 and 6) relative to the size on day 0 (immediately after wounding) in a spreadsheet. Accomplish this by dividing the size of the wound on each day by the size of the wound on day 0 and converting that value to a percentage. 

NOTE: Under normal conditions using this method of colonoscopic viewing, the greatest closure of the wound is observed after the first 2 days (~75% reduction in size) with more gradual closure on days 4 and 6 (~80% and ~95% reduction in size, respectively). 

3. Collection of the wound bed for molecular analysis

3.1. Euthanize mouse using CO2 asphyxiation followed by cervical dislocation (or equivalent technique) on the selected day following biopsy. 

3.2. Harvest the distal region of the colon by opening the skin and abdominal muscle to expose the body cavity. Place closed scissors under the colon and gently lift to release it from the underlying mesentery and then cut the colon at its midpoint and at the anus to remove it from the mouse.

3.3. Flush fecal content using a rat gavage needle attached to a 20 mL syringe filled with ice-cold 1x PBS then lay down the colon onto filter paper.

3.4. Cut open the colon longitudinally on filter paper ensuring that the mesenteric side is face down against the filter paper. Apply 0.2% methylene blue to the mucosa using a squeeze pipet while tissue is still on the filter paper and then drain off excess methylene blue. View the colon under a dissecting microscope and locate the wound bed (Figure 3A).

3.5. Using 4 inch micro iris scissors, cut around the edge of the wound bed (Figure 3A, dashed circle) being careful not to cut into the muscle layer (unless the muscle is desired) and transfer the dissected wound bed to a tube using fine point tweezers for snap-freezing or desired storage method. 

NOTE: The amount of tissue collected in this manner is enough for extracting RNA for RNA-seq or equivalent analysis. 

4. Preparation of tissue for histological analysis

4.1. Euthanize the mouse and harvest the colon as described in step 3.1-3.2. 

4.2. Cut open the colon longitudinally on filter paper ensuring that the mesenteric side is face down against the filter paper. Gently apply 4% paraformaldehyde (or fixative of choice) using a squeeze pipet and cover the tissue with parafilm. Leave flat in a sealed container for 4-6 hours. 

4.3. Transfer tissues to 70% ethanol for storage. When ready to process the tissues, remove parafilm and apply 0.2% methylene blue to the mucosa using a squeeze pipet while tissue is still on filter paper. Then drain off excess methylene blue. 

4.4. View the colon under a dissecting microscope and locate the wound bed (Figure 3A). Using a scalpel with a #10 blade, cut directly through the center of the wound bed and continue cutting through the remainder of the colon in a straight line, such that the colon has been cut in half, length-wise (Figure 3A, black line). 

4.5. Process the colon and then paraffin embed (either one or both sides that remain after cutting) such that the side that was cut by the scalpel (the side that was the center of wound bed before bisection) is face down in the paraffin. Proceed to cutting sections and staining for desired stain(s) or maker(s). 

4.6. If cryosections are required for a given staining, harvest the colon as described in step 3.1 and open longitudinally on filter paper, ensuring that the mesenteric side is face down against the filter paper. 

4.7. Bisect the wound bed within the freshly harvested colon as described in step 4.5 and embed the colon (either one or both sides that remain after cutting) such that the side that was cut by the scalpel is face down in a base mold half-filled with tissue freezing medium.

4.8. Secure the tissue in place with fine tweezers and place the base mold onto a metal plate on top of dry ice to harden the freezing medium. Once the bottom portion of the medium is frozen (and the tissue is held in place), release the tissue and fill the remaining volume of the base mold with freezing medium and place back onto dry ice. 

4.8.1. After the entire volume of freezing medium is frozen, transfer to a -80 °C freezer until sectioning.

4.9. For paraffin or frozen sections, cut and stain additional sections by H&E to ensure that the wound bed has been captured on the section before proceeding to study-specific staining. Figure 3B shows an example of a section in which the wound bed can be clearly observed. 

REPRESENTATIVE RESULTS:
The small items (lens, sheath, biopsy forceps) needed to carry out biopsies are shown in Figure 1 along with indicators of proper assembly of these components. Figure 2 shows representative images of acceptable views of the wound bed in order to accurately quantify the size of the wound bed and closure rate of the wound. An example of an ex vivo view of the wound bed is shown in Figure 3A inclusive of indicators of the perimeter of the wound bed (indicating the region to excise for molecular analysis) and where to cut the tissue in order to enable visualization of the wound bed upon sectioning. Figure 3B shows a representative image of an H&E-stained section in which the wound bed can be clearly observed. Supplemental Video 1 provides a view of the biopsy procedure from inside the mouse’s colon. 

Figure 1: Items needed to carry out biopsies. (A) Image of (a) lens, (b) sheath and (c) biopsy forceps. (B) Insertion of the lens into the sheath. (C) Insertion of forceps through the working channel of the sheath (solid arrow). Dashed arrow indicates correct location for attachment of air pump. 

Figure 2: Colonoscopic images of wound bed following biopsy. Still images were created from video recordings of colonoscopies immediately after biopsy (Day 0) and 2, 4, and 6 days later. Blue lines indicate the edges of the wound beds at each time point. The arrow indicates the correct length of extension of the forceps into the lumen to ensure proper distance from the lens to the rectal wall, in order to ensure consistent measurements of the wound bed over time. 

Figure 3: Ex vivo and sectioned images of wound bed. (A) A colon was harvested from a mouse 2 days following biopsy, stained with 0.2% methylene blue and imaged under a dissecting microscope. The dashed circle indicates the edges of the wound bed. The black line indicates the proper location to bisect the wound bed/colon prior to embedding for sectioning. (B) Representative image of an H&E-stained section of a wound bed. Asterisks indicate wound bed and arrows indicate intact crypts adjacent to wound bed indicating the borders of the injured region. 

Supplemental Video 1: Biopsy procedure and wound bed imaging. 

DISCUSSION:
Ensuring consistent and accurate biopsies as well as measurements of wound size are of paramount importance when attempting to effectively evaluate the rate of wound closure in this model. Therefore, several measures should be taken to be confident that the procedures are being correctly carried out. First, the depth of the biopsy must not be too shallow or deep. If too shallow, there will not be a sufficient window to evaluate wound closure. Figure 2 demonstrates an optimal biopsy depth and size on day 0. Note the clear distinction between the mucosa around the wound bed and the tissue that remains beneath the wound bed (Figure 2). If the biopsy is too deep, perforation can occur thus resulting in an unevaluable mouse. Upon insufflation after biopsy on day 0, if the mouse’s abdomen becomes severely distended, perforation has occurred and the mouse cannot be used for evaluation and should be euthanized. It is helpful if the same individual carries out the biopsies for a given study to further ensure consistency. Second, it is critical to carry out the biopsy in the rectum and not in a more proximal region. Given that the rectum is thicker than more proximal regions of the colon, there is a markedly reduced chance of perforation. A mark should be made on the outside of the sheath 0.5 cm from the end and the endoscope should only be inserted up until that point to ensure that the biopsy forceps will not extend beyond the rectum. Third, having the right amount of insufflation both during the biopsy and for visualizing the wound bed is essential. During biopsy, if the colon is too distended the colonic wall will be too taut and there will not be a sufficient amount of mucosa to biopsy. Therefore, it is suggested that the individual operating the endoscope not press their index finger against the open end of the gas valve, in order to allow for minimal air flow into the colon. However, the opposite approach should be used when visualizing wound beds for the purposes of measuring wound size. Once the wound is located, fully insufflate the colon by pressing the index finger firmly against the open end of the gas valve and hold it there until a desired view is obtained. The colonic wall should be as taut as possible for this purpose. Of note, full insufflation of the colon is important for also ensuring consistent lateral views of the wound bed. Lastly, it is critical to ensure that a consistent distance is maintained between the lens and the wound to enable accurate measurements over multiple colonoscopies in the same mice. A closer distance will artificially make the wound bed appear larger than it is and a farther distance will make it appear smaller. Therefore, using the biopsy forceps as a guide to maintaining distance is very useful. 

In addition to the major considerations to take into account when using this model, there are more minor points to be aware of that can also impact the ability to perform this procedure effectively. For example, it should be made certain that the colonic lumen is clear when performing colonoscopies. Although fecal material is cleared by flushing with PBS, additional material can descend into the rectum after inserting the endoscope. Moreover, when visualizing the wound bed immediately after biopsy, blood can obscure the field. Therefore, it is sometimes necessary to remove the endoscope from the rectum, flush the colon with PBS to clear the luminal blood and reinsert the endoscope to visualize the wound bed. In certain cases, blood and other luminal content can become adhered to the lens, obscuring the field. In these cases, the endoscope should be removed from the mouse and the lens should be wiped using the brush before continuing imaging. 

Prior to the advent of the colonoscopic-guided pinch biopsy model, researchers had limited model systems to investigate colonic wound healing. One approach was to evaluate the recovery from exposure to chemical inducers of colonic injury such as DSS8. However, this approach does not allow for precise control of the extent of injury being induced nor the location of the injury throughout the colon. Moreover, precise measurements of mucosal healing in real-time can be challenging with these chemical models. Although useful, the biopsy model also has limitations. For instance, operators are limited to carrying out wounding in the distal colon. This limitation prevents studies of small intestinal ulceration, an important clinical issue. Additionally, although this technique recapitulates some aspects of IBD pathogenesis, it cannot be considered a true model of this disease. Of technical consideration, it can be challenging to induce consistent wound sizes across mice, generate evaluable wounds, or locate wound beds at the later stages of the wound healing process. When taking these points into consideration, it is advisable to begin studies with additional mice to account for the loss of unevaluable samples. 
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